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Welcome to PhotoTune
PhotoTune gives you expert color without having to understand color theory or the complex 
controls in Photoshop. PhotoTune’s twin modules help you color correct your images using 
two different methods. First is ColorTune, If you have ever been to the eye doctor you already 
know how to use it. Simply compare and click on the best image to correct your color, 
contrast and brightness in one simple screen. No need for complicated dials, just pick which 
image looks best. Second is SkinTune, specially designed for correcting skin color. Just click 
on a skin tone and it automatically color corrects your image based on years of research and 
thousands of samples of skin color. Advanced users still have access to fine-tune controls for 
color cast removal, brightness, contrast, dynamic range and saturation. You can even create 
presets that you can use over and over again.

ColorTune
There are several parameters that need to be adjusted to enhance and image, either to make 
it true to life or a more pleasing rendition. These include brightness and contrast (tonality) 
and color. To adjust these parameters in Photoshop requires several dialogs and an advanced 
knowledge of color theory. This is far beyond what many photographers, casual or profession-
al know how to do. ColorTune is a designed to make correcting images a breeze. Rather than 
having a series of complicated sliders and dials, you simply compare two images side by side 
and pick the best looking one. This patented step by step process will correct the contrast, 
brightness and color of an image in just a few clicks by guiding you through the proper steps. 
Advanced users still have access to manual controls even advanced highlight and shadow 
tools. Plus its easy to save settings so they can be applied again to a group of similar images.

SkinTune
Human skin color occupies less than half of one percent of all visible colors, yet its easy to see 
when someone’s skin color is incorrect in a photograph. Correcting it on the other hand can 
be very difficult. Identifying the color cast and making the delicate adjustments needed takes 
a steady hand and a trained eye. With SkinTune, we have made this process faster and easier. 
We have combined years of research and thousands of skin color samples with a fine-tune 
controls designed just for correcting skin. Simply start by clicking on the subjects skin and 
SkinTune automatically removes the color cast and leaves you with specialized tools to correct 
brightness, contrast, saturation as well as fine-tune color with the extra precision needed for 
correcting skin.
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System Requirements
Macintosh

•	Mac OS X 10.4.10 or higher

•	1GHz or faster G4, G5 or Intel Core Processor(s)

•	512 MB minimum application RAM

•	100 MB of available hard disk space

•	Adobe Photoshop CS2 (9.0.2), CS3, Elements 4.0.1 or higher

• Internet Connection & Adobe Flash 9 Player

• Adobe Acrobat Reader 6 or higher

Windows
•	Windows XP, Vista or higher. 

•	1GHz or faster Pentium 4 Processor(s) or equivalent

•	512 MB of  application RAM

•	100 MB of available hard disk space

•	Adobe Photoshop CS2, CS3, Elements 5.0 or higher

• Internet Connection & Adobe Flash 9 Player

• Adobe Acrobat Reader 6 or higher

PhotoTune will only install and function with 
Adobe Photoshop or Photoshop Elements 
and will not function with other applications 
that support the Adobe Photoshop Plug-in 
architecture.

Installation
To install onOne PhotoTune 2, select install PhotoTune from the product CD or download.

Macintosh
•	The installer installs all necessary files into all supported versions of Photoshop and Photoshop 

Elements.

•	 If more than one copy of the same version of Photoshop is found, PhotoTune 2 will be installed in 
all of them. 

•	PhotoTune 2 is installed into the “Plug-Ins” folder inside of the :Applications:Adobe Photoshop 
folder.

The PhotoTune 2 Preferences files on the Macintosh are created in the installing user’s 
:Library:Preferences directory.

Any other required files will be installed in Applications directory.

 

Windows
•	PhotoTune 2 is installed into any supported version of Photoshop or Photoshop Elements. 

•	PhotoTune 2 is installed into the “Plug-Ins” folder in Photoshop. 

All other required files are installed in the PhotoTune 2 directory in your Program Files direc-
tory.

Registration
It is important to register your copy of onOne PhotoTune 2 so we can provide you with the 
best possible service. Registered users of onOne PhotoTune 2 are eligible for technical support, 
free updates and information regarding new versions and products, discounts and special of-
fers on new products. The Registration application will launch automatically after you install 
PhotoTune 2 and will guide you through the registration process.

Your serial number is located on a sticker inside the PhotoTune CD case or in your email 
receipt. You will need to enter that number to personalize your copy of PhotoTune 2.

Technical Support
Technical Support is available directly through the onOne Software web site. Please fill out an 
online support form at http://www.onOnesoftware.com/support.html for the quickest response. 
See the contact page at the beginning of the guide for additional contact information.

Before contacting support please check the onOne website for frequently asked questions, 
how-to videos and troubleshooting tips.

When contacting technical support, please be at your computer and have the following 
information available: 

• Your serial number

• Your computer configuration

• Your question or a description of the difficulty you’re experiencing - what specifically occurs and 
when 

Take note of any displayed error numbers or messages and any other information you think  
may be relevant.
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Welcome To ColorTune
ColorTune is designed for photographers, artists and graphic designers who want great look-
ing images, but would rather not sit in front of a computer all day. Since the advent of digi-
tal imaging, we all spend too much time fixing photos, and not enough time taking photos. 
That just doesn’t seem right, so we work hard everyday to solve that problem. ColorTune is 
our solution. 

It Works Like An Eye Exam

ColorTune is a Photoshop Plug-in that works like an eye exam to figure out precisely what 
is wrong with your photo and how to fix it. During each step of the Wizard process, you are 
presented with two preview images that have been altered in different ways. All you do is 
pick the better image from each pair. ColorTune instantly and scientifically analyzes your 
feedback to determine exactly what you want. In about 20 seconds, ColorTune produces a 
corrected image, which you can fine-tune in full 8 bit or 16 bit precision.

ColorTune takes care of all your correction needs, including dynamic range, exposure, satu-
ration, and color balance. There’s even a great highlight and shadow feature built right in. 

It doesn’t matter if you’re a color expert or a Photoshop novice, ColorTune will save you a 
lot of time and effort. No longer will you have to jump from one feature to another, tweak-
ing and experimenting in hopes of finding the perfect correction.   

High Tech Made Easy

ColorTune looks easy, because it is easy, but don’t be fooled by that friendly exterior. Under 
the hood, ColorTune is an extremely complex, sophisticated, and ingenious software tool. 
Ponder this, ColorTune’s Color Wizard contains thousands of different color correction 
combinations. And, it finds the best single solution in less then 20 seconds. 

It’s About Time & Quality

If you spend an average of 10 minutes fixing an image with Photoshop’s Curves, Levels, 
Color Balance, Hue & Saturation, and Highlights & Shadows, it’ll take you 16 hours to color 
correct 100 images. With ColorTune, you’ll be done in less than one hour. 

We understand that quality is just as important as saving time. That’s why you’ll appreciate 
all the extra effort that went into our advanced color technology. ColorTune offers you the 
best of both worlds; great looking images in a fraction of the time normally associated with 
color correction in Photoshop.

Stay Focused On Photography

At some point, photography became your passion. Then, the computer and software, which 
was supposed to make your life easier, became an annoying bottleneck. With ColorTune, 
you’ll have lots of extra time to pursue your passion. Welcome back to photography!
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Progress Bar

The progress bar shows the status of the Wiz-
ard, and it can be used for navigation.

Red Icons represent steps that have been 
completed. 

Green Icon indicates the active  
current step. 

Blue Icons are for upcoming steps.

Zoom Slider
When you open ColorTune, your 
image is reduced to fit. Moving  
the Zoom slider handle up in-
creases the image size, while down 
reduces the size.

Tools

Arrow for selecting previews.

Hand for panning the image.

Camera to make a Snapshot.

Wizard Panel
There are two different panels in ColorTune. The Color Wizard, shown here, 
automatically appears when you open an image. 

The Wizard works like an eye exam by displaying a series of six side-by-side 
preview images with different effects applied to each preview. All you do is 
choose the better preview of each pair by clicking on the image of your choice. 
Continue choosing the better preview until all six steps are complete.

• Your original image will not be shown during the Wizard process.

• A preview must be selected on each step. You can not skip any steps.

• Each response gives ColorTune a clue to what you want. After six steps, Color-
Tune switches to the Fine-Tune Panel and displays a corrected image next to 
the original.

Back Button. You may return to a 
previous step by clicking on any of 
the red buttons to the left of the 
active green icon.

Restart Button. To restart the Wiz-
ard process, click on the first red 
button (far left) on the progress bar. 

End Button. To stop the Wizard 
and switch to the Fine-Tune panel, 
click the end button, or the Fine-
Tune button.

Wizard Slider
The slider lets you increase or  
decrease the amount of alteration used 
during each step.
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Six Steps To Better Color
ColorTune is a patented color correction system that quickly and easily fixes an image’s 
dynamic range, exposure, and color balance. Color is by far the most difficult and important 
aspect of the correction process. A combination of six colors (R, G, B, C, M, Y) can be used 
to color balance an image and remove an unwanted color cast. That equates to a staggering 
16.7 million color possibilities. The job of the Color Wizard is to evaluate your feedback and 
eliminate color parameters from consideration until only two candidates remain. Next, the 
Wizard determines the final parameter, and determines an appropriate amount. The Wizard 
will dramatically speed up the correction process.

Like an eye exam, your response to each step determines the direction of all subsequent steps. 
The first step is used to set dynamic range. Step 2 adjusts the brightness. And, the final four 
steps determine a color correction. More steps are required in the color section due to the 
complexity of color balance. Since the step-by-step process follows the same sequence each 
time, the more you use ColorTune, the more proficient you’ll become. 

Here’s our best advice for making appropriate choices for each step:

• 	Relax and have fun, ColorTune will do most of the work for you. 

• 	Don’t over-analyze. Your first impression is usually your best choice.

• 	Choose vibrant, pleasing colors. A flat, dull appearance is usually a bad sign. 

• 	Consider the overall appearance first, and then check important areas like a face, or an area 
that should be a neutral gray.

• 	Move the slider up and down to help decide which preview is better.

The Best Color Results
The Wizard records information on Step 1, Step 2, and Step 6. So, make sure you set the 
proper amount on these steps. This fact should influence the way you use the Wizard. Steps 
3-5 are preliminary steps used to find the best color parameter. Since the amounts are not re-
corded on these steps, you don’t need to spend 
too much time adjusting the slider. The key is 
to use a slider setting that aides in your decision 
making process. Then, set the slider for the 
proper amount on the last step (step 6). 

The 6-step Wizard will assure that you  work with a set of transformations that are non-op-
posing. It is the most direct and efficient means of color correction ever devised. After correct-
ing a few images, you’ll gain a profound appreciation for ColorTune and the results that you 
are able to obtain. You’ll wonder how you ever lived without it. 

❶ ❷

❸ ❹

❺ ❻

Sound Effect

Between each step of the Wizard process, there is a horizontal image wipe and a sound effect 
for added user feedback.

If you want, you can turn the sound effect off:

1. Start ColorTune.

2. Click the “i” button in the top right corner of the ColorTune window. 

3. From the pop-up menu select “Turn Sound Off.” 

This will change the default, so the sound effect will remain off unless you turn it back on.
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Fine-Tune Panel
The Fine-Tune Panel appears after the Wizard 
process is complete. It displays the Original 
image along side the Current corrected im-
age, and provides a complete set of tools to 
help you fine-tune and perfect the results. 

Reset Button

Clicking the Reset button opens a dialog 
box containing five different options that 
can be used to restart the Wizard process, or 
reset the sliders in a number of ways. The 
options are:

1. Restart ColorTune.

2. Reset to Wizard amounts.

3. Reset amounts to last saved.

4. Use 3 complementary color sliders.

Highlight/Shadow Points

Many digital images have a flat appearance 
due to a compressed dynamic range. This 
happens when pixel values don’t extend to 
the maximum range from 0-255, like on a 
hazy or cloudy day. Highlight/Shadow con-
verts the lightest pixels to white, the darkest 
pixels to black, and remaps all the pixels in 
between. 

 

Snapshot

The Snapshot button lets you make 
a temporary copy of the Current 

preview, along with a record of your cor-
rections. You can make a maximum of 4 
Snapshots on the Fine-Tune Panel, along 
with a single Wizard Snapshot. 

Snapshots are a handy feature that let you 
compare different results, and experiment 
with different alterations without losing 
your prior changes.

The pop-up menus under each preview im-
age control Snapshot displays.

Highlight & Shadow Tab

Tab buttons at the left end of the slider box 
let you switch between Basic sliders and 
Highlight & Shadow (H&S) sliders.

ColorTune’s H&S adjustments offer more 
control than similar features in Photoshop, 
by allowing you lighten and darken, as well 
as change color in these critical areas. 

Basic Sliders

Basic sliders contain adjustment controls for 
color, brightness, contrast, and saturation. 
Color and brightness are set to the amount 
determined by the Wizard. Only two colors 
sliders are provided because adjusting more 
than two colors is counterproductive.
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Fine-Tune Panel

The Fine-Tune panel contains a complete set of sliders and tools for adjusting and fine-tuning 
your image. 

First Color Slider

The first color slider is set with the color and amount that was determined by the Wizard. The 
Wizard is accurate within 2-3%, so when fine-tuning, you can usually stay within this range. 
The Color sliders have a maximum range of 0 to 50.

If you experimented with different values, and want to reset the sliders to the Wizard 
amount, just click on the Reset button, and choose “Reset to Wizard amounts”, or choose 
“Wizard Snapshot” from the Edit pop-up menu. 

Second Color Slider
A second slider displays the second color parameter, which was determined during the Wiz-
ard. The default amount is set to 0%, because a second color is usually not required. If it is 
needed, the value will normally be less than half the amount used for the first color slider.

Color and brightness adjustments use an exclusive curve adjustment, as 
shown here. This method is designed to prevent data loss. The largest 
change occurs in midtone and shadow areas that contain the highest 
levels of saturation, with a less pronounced effect in the highlight areas.

Brightness

The Brightness amount is determined by the Wizard. Again, the amount may need to be 
adjusted up or down slightly. The Wizard provides a maximum brightness change of 50%, but 
this can be increased to 100% with the Fine-Tune slider. The Wizard is accurate within 4-5%, 
so when fine-tuning, you can usually stay within this range.  

Contrast
The contrast slider uses a custom S-curve that increases highlights, while decreasing shadows. 
An S-curve is the preferred method of professionals. The available range is -50% to +50%, in 
1% increments.

ColorTune’s Contrast uses a custom S-curve adjustment, with 
highlights moving in the opposite direction of shadows. This method 
is designed to prevent data loss. On most images, you’ll find that a 
1-5% increase will provide the necessary “snap” to improve contrast.

PRO Saturation Algorithm

Saturation is used to adjust the color intensity of an image. Most of the time, the Color Wiz-
ard will correct saturation by achieving proper color balance. If you need to fine-tune satura-
tion, the slider has a range of -100% to +100%.

Our exclusive saturation algorithm evaluates every pixel’s saturation value before making an 
adjustment.

Check the samples below. It clearly shows that ColorTune does a better job than Photoshop at 
adjusting saturation. Notice how intelligently ColorTune handles neutral areas, like grays and 
blacks. Each pixel is adjusted independently, instead of globally to avoid over-processing.

ColorTune Saturation Photoshop SaturationOriginal image
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Reset Button

The Reset button gives you four options:

1. Restart ColorTune.

	 This option restarts ColorTune. Step 1 is displayed, and the entire process starts over from 
the beginning, just like starting a new session. Any changes made to the image will be lost.

2. Reset to Wizard amounts.

	 ColorTune’s Color Wizard produces a brightness setting, a color setting, and a Dynamic 
Range setting. This Reset option resets those items to the amounts that were established 
during the Wizard process. Any other alterations you’ve made will be retained.

3. Reset amounts to lasted saved.

	 This reset option reverts all items to the amounts that were established during the Wizard 
process. So, any alterations you’ve made will be removed.

4. Use 3 complementary color sliders.

	 This option displays three pairs of complementary color sliders instead of ColorTune’s 
default of two. The previous two slider amounts are retained. The slider pairs are:

		  Cyan/Red, Magenta/Green, and Yellow/Blue

16 Bit Support

Most high-end digital cameras now feature a RAW image format in addition to JPEG. RAW, as 
the name implies, is the raw file with no camera processing like sharpening, white balance, or 
color adjustment. Another advantage of RAW is more pixel data with 16 bits of information 
per channel rather than 8 bit. Standard 8 bit provides 256 levels of data for each of the three 
channels in RGB. This equates to 16.7 million different colors. 16 bit increases each chan-
nel’s data to from 256 to over 65,000 levels. 16 bit helps prevent image degradation during 
manipulation and color correction.

At start-up, ColorTune will automatically recognize 8 or 16 bit images and process them ac-
cordingly.

Window Resizing

To resize the ColorTune window, just click and drag the bottom right hand corner of the 
window with your mouse to resize the window. The standard close, maximize, and minimize 
buttons are also available at the top of the window.

Highlight/Shadow Points

Many digital images have a flat appearance due to a com-
pressed dynamic range. This happens when pixel values don’t 
extend to the maximum range from 0-255. The Highlight/
Shadow control converts the lightest pixel to white, the dark-
est pixels to black, and remaps all the pixels in between. A per-

centage of pixels on each end of the spectrum are clipped to insure a proper result. Clipped 
pixels are converted to black or white. The clipping amount is adjustable by selecting one of 
the five preset clipping amounts in the Highlight Clip and Shadow Clip pop-up menus. You 
should use the smallest amount possible to avoid excessive data loss, and an overly contrasty 
appearance.

Pop-up choices are:

Highlight and Shadow Adjustment Tab

Tab buttons at the left end of the slider box let you switch between  
Basic sliders and Highlight & Shadow (H&S) sliders.

Sometimes an image requires special attention in the shadow or highlight areas. A good 
example would be to darken and add blue to the sky. Or, remove a color to make the shadows 
more neutral.

ColorTune’s Highlight and Shadow (H&S) adjustments isolate the tonal regions very precisely 
to insure that transitional areas have a smooth and flawless gradation. We spent months fine-
tuning and testing our results to make your job easy.  
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Using The Snapshot Function
The 6-step Wizard automatically makes a Snapshot at the conclusion of the Wizard process. If 
you manually take a Snapshot during the Wizard process, it will replace the automatic Wizard 
Snapshot. The Wizard Snapshot is recorded in the pop-up menus under the preview images 
on the Fine-Tune Panel.  

The Snapshot button (camera) on the Fine-Tune Panel, is located under the right-hand pre-
view image. You can record up to four Snapshots in addition to the Wizard Snapshot. After 
that, you will be prompted to replace a Snapshot whenever you make a new Snapshot.

 A Snapshot makes a temporary copy of any state of the image, and lets you work from that 
point forward. In this way, you can experiment, or compare different effects while retaining a 
copy of your previous edits.

For example, you can make changes and tweak colors, take a snapshot, and then display and 
compare different versions side-by-side. Then, take another Snapshot any time you have 
made an improvement, so you can recover your work easily. Just select a Snapshot from right-
hand pop-up menu to recall the previous saved version. 

The “View” and “Edit” pop-up menus, located under the preview images, are used to control 
and manage the Snapshot functions. When a Snapshot is selected from the right-hand pop-
up menu, the sliders are updated to reflect the adjustments saved with the Snapshot. Only 
the right-hand preview can be edited. Displaying Snapshots in the left-hand preview are for 
display purposes only.  

The pop-up menus contain the following items:

Left Menu Right Menu

Original Current

Wizard Snapshot Wizard Snapshot

Snaphot 1-4 Snapshot 1-4

Save History...

Load History...

	 		
Managing Snapshots 

Every time you make a Snapshot, it is listed in both pop-up menus located under the preview 
images. You can use the pop-up menus to display any combination of Snapshots you’d like. 
Only the preview image on the right can be edited and altered with the sliders. Whenever a 
Snapshot is displayed on the right, the sliders are updated to show the recorded adjustments 
that were saved with the Snapshot. You could load Snapshots on both the left and right, so 
you can compare two images side-by-side while you make changes.

If you make changes to a Snapshot, and then switch to a different Snapshot, ColorTune will 
ask if you want to save the changes before you switch. 

If you want to make a new Snapshot, and you’ve used up your allotment of 4 Snapshots, 
ColorTune will ask you which of the current Snapshots you want to replace. 

Typical Workflow
Like everything in ColorTune, Snapshot is designed to speed up the correction process. Snap-
shot is a safety net that lets you continue experiment with different combinations without 
losing your previous edits. Take a Snapshot whenever you want to preserve a set of correction 
parameters so you can continue experimenting with impunity. Here’s a typical workflow us-
ing Snapshot:

1.	 After the Wizard, a Snapshot is automatically taken (Wizard Snapshot).
2.	 Fine-Tune the results obtained by the Wizard.
3.	 Take a Snapshot to record your adjustments.
4.	 Then experiment some more, and make another Snapshot.
5.	 Use the pop-up menus to compare different Snapshots.
6.	 Save History if you want to reuse your changes on a future image, or click 		

OK to process the changes shown in the right-hand preview.

Save History and Load History 

Snapshots are a temporary record of your image adjustments. But, you can permanently save 
an unlimited number of Snapshots to disk. To save on your hard disk, choose the Save His-
tory option in the Current pop-up menu, and specify a name and location for the file. Use 
the Load History option to open a previously saved setting. Load History will overwrite and 
become the Current preview. Then, you can edit the Current image using all of the tools on 
the Fine-Tune Panel.
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Photoshop Layers

Photoshop lets you place artwork on separate layers to 
make the construction of composite images easy. Color-
Tune is designed to work with Photoshop layers, so you 
can color correct individual elements separately.

To use ColorTune with layers
1. Display the Layers palette (choose Window>Layers).

2. To activate a layer and work on its contents, click on 
the appropriate layer name listed in the Layers palette. 
The layer is highlighted to show that it has been selected. 
Then, open ColorTune.

3. To work on a portion of one layer, select the layer as 
described above and use a selection tool to select a portion 
of that layer. Next, open  
ColorTune. The adjustments will be applied to the selected 
area.

Batch Processing

ColorTune supports Photoshop’s Action Palette, so multiple images can be processed auto-
matically, with ColorTune’s functions.

Using Photoshop’s Actions 
1. From within Photoshop’s Action Palette, start a new Action. 

2. Photoshop will record every step, including ColorTune functions, so they can be replayed 
on an image or a batch of images automatically. 

3. To replay the action on a single image, select the action in the action palette, and select 
“play.”

To replay the action on multiple images, choose Automate>Batch from Photoshop’s File 
menu. A dialog lets you select an action, choose a folder of images to process, and set other 
parameters for opening, closing, and saving files.

To use ColorTune on selected areas
1. Choose any of Photoshop’s selection tools and select a portion of 
the image.

2. Open ColorTune, and make changes as you normally would. The corrections will only be 
applied to the selected areas.

Using ColorTune With Photoshop Fade

ColorTune supports Photoshop’s Fade command, which is located in the Edit menu. This 
allows you to reduce the effect of ColorTune’s last adjustment from 0-100%. The Fade com-
mand is similar to changing the layer opacity in Photoshop’s Layer Palette.

Last Filter

ColorTune supports Photoshop’s Last Filter command located at the top of the Filter menu. 
This lets you replay ColorTune’s last correction on other images. The menu item is available 
until you use a different filter.

Photoshop CS3 Smart Filters 

Smart Filters is a great new Photoshop CS3 feature 
that essentially let plug-ins work like Adjustment 
Layers. ColorTune is compatible with CS3 Smart 
Filters, so adjustments can be recorded as a sepa-
rate layer, and you can double-click the layer to 
edit ColorTune’s alterations. This means you can 
use ColorTune to perform nondestructively editing 
when used on a Smart Object. 

Smart Filters are stored as layer effects in the Layers 
palette and can be readjusted at any time, working 
from the original image data contained in the 
Smart Object. Add, adjust, and remove filters from 
an image without having to resave the image or 
start over to preserve quality. Nondestructive Smart 
Filters allow you to visualize changes without altering original pixel data.

To use Smart Filters:

1. First change the image layer to a Smart Object. In the Layer menu or Layer Palette options, 
choose Smart Object > Convert to Smart Object. 

2. Then use ColorTune to color correct the image.

3. To edit the ColorTune Smart Filter, double-click the layer.

4. When ColorTune opens, switch to the Fine-Tune panel and select Last Filter from the Edit 
pop-up menu under the right-hand preview image. 

If you are not using the Smart Filter feature, Last Filter will apply the same change that was 
made during the previous ColorTune session.
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Skin Color Research
Correcting skin color is one of the most daunt-
ing, and time-consuming tasks professional 
photographers face every day. The problem is 
that the range of acceptable skin color is very, 
very limited, and it varies slightly for different 
races. 

We spent years studying skin color, and col-
lecting thousands of sample images from 
around the world. Then, we took precise spec-
trophotometer measurements and compiled 
a complete reference database of acceptable 
colors. What we discovered is that skin color 
represents less than half of 1% of all available colors. So, it’s no wonder that correction is such a 
difficult process.

Our next step was to construct complete libraries for different races, including African, Asian, 
Caucasian, Latin, and Middle Eastern. Each library contains between 120,000 and 150,000 colors 
made up of different combinations of hue, brightness, and saturation, based on the unique charac-
teristics of each race.

Custom Tools

Understanding skin color was only half the battle. It was obvious that we also needed to create 
specialized tools designed specifically for skin color adjustment. One thing you’ll notice with Skin-
Tune is that all the adjustments are totally independent, so adjusting brightness, as an example, 
has no effect on hue or saturation. This is important because an adjustment of as little as 1% can 
easily result in an unwanted result. 

Most people don’t realize that you can’t adjust brightness in Photoshop Levels or Curves without 
altering hue. That is okay under most circumstances, but not with skin color where hue is the most 
critical component in achieving accurate results.

Finally, we needed to find a way to increase the precision of SkinTune to provide maximum control 
over the skin color spectrum. Our tools are twice as precise as Photoshop so you can make very 
subtle adjustments and achieve life-like results. As you can tell, we worked hard to make your job 
easy.

Our Heritage

Like all of our award-winning programs for professional photographers, SkinTune has a unique and 
elegant interface. Corrections are fast, easy, and mistake-free. With SkinTune added to Photoshop, 
you can spend more time behind a camera, taking photos, and less time in front of a computer, 
fixing photos.

Welcome To SkinTune
If you’re a fashion, portrait, or wedding photographer, you know first-hand how difficult it is to 
correct skin color. You tweak, adjust, and experiment with Curves, but the slightest alteration can 
cause an unwanted color shift. 

With SkinTune, all you do is open an image in Photoshop, select PhotoTune SkinTune from the 
Filter menu, click to select a color, and SkinTune automatically corrects your image. After SkinTune 
does its magic, you’re free to fine-tune the results by adjusting hue, brightness, contrast, satura-
tion, and dynamic range.

The skin color spectrum is less than 1% of all 
available colors.
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3.	 You can randomly correct the image using any tool, but the suggested  
sequence (below) can help produce better results in less time:

		  A. First, adjust the Hue by clicking on different color swatches.

		  B. Then, adjust the Brightness slider until you are pleased with the results.

		  C. Next, work on Saturation.

		  D. Finally, use the Equalize Color sliders to fine-tune the skin color. 

Quick Start
1.	 To begin, open an image in Photoshop, and then choose PhotoTune SkinTune from Photo-

shop’s Filter menu.

	 SkinTune can open 8 bit and 16 bit RGB files. 

	 When SkinTune opens, a single image is displayed in the left preview area. All the tools are 
grayed out and inaccessible. Only the Zoom slider and image panning can be used at this time.

2.	 The first step is to use your mouse to select a flesh tone in the original image. After you click, a 
contextual menu appears listing the available skin color libraries. Choose 
a library.

	 After selecting a library, a new Current image is displayed, and all the 
tools are active and ready to use.
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Interface Design
After you click to select a flesh tone, SkinTune 
displays your Original image alongside the 
Current corrected image. A complete set of 
tools lets you fine-tune and perfect the results.

Color Swatches

SkinTune displays a set of colors that can be 
used to adjust the Current image. The active 
color is highlighted with a blue outline. Click 
on a different color to choose a new target 
color. 

The color swatches contain different color vari-
ants or hues with warm colors to the left and 
cool colors to the right. Equalize sliders adjust 

Ethnicity Pop-up Menu
Skin color Libraries for African, Asian, Cau-
casian, Latin, Middle Eastern, and All are 
available under the pop-up menu. Each library 
contains more than 120,000 skin colors.

Percentage Pop-up Menu
SkinTune adjusts your image to the nearest tar-
get color in the chosen library, based on your 
click point. The 50% option cuts the adjust-
ment in half, while 25% reduces the adjust-
ment in half, again. 0% is also available.

Snapshot
The Snapshot command lets 
you make a temporary copy of 

the Current preview, along with a record of 
your corrections. That way, you can compare 
different results, and experiment with different 
alterations without losing your prior changes.

The Original and Current Pop-up menus under 
the preview images control Snapshot func-
tions.

Zoom Slider

To begin, the image is always reduced to fit. 
The vertical Zoom slider lets you increase or 
decrease the size of the preview images.

Pan Tool

If the image is cropped, you can 
reposition it using the pan tool. Just place your 
mouse over the right-hand preview image, 
then click and drag.

Brightness Slider

The brightness slider uses a  
custom midtone curve that lightens or darkens 
the image without data loss. The midtones are 
affected more than the highlight and shadow 
regions.

Contrast Slider

The contrast slider uses a custom S-curve 
that increases highlights, while decreasing 
shadows.

Saturation Slider

To start, saturation matches the click point of 
your original image. Adjusting saturation will 
not effect color or brightness.

Equalize Color

To the right of the main sliders are the Equalize 
Color sliders. These sliders can be used to fine-
tune the skin color.
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16 Bit Support

Most high-end digital cameras now feature RAW image format in addition to JPEG. RAW, as the 
name implies, is the raw file with no camera processing like sharpening, white balance, or color 
adjustment. Another advantage of RAW is more pixel data with 16 bits of information per chan-
nel rather than 8 bit. Standard 8 bit provides 256 levels of data for each of the three channels in 
RGB. This equates to 16.7 million different colors. 16 bit increases each channel’s data to from 
256 to over 65,000 levels. 16 bit helps prevent image degradation during manipulation and 
color correction.

At start-up, SkinTune will automatically recognize 8 or 16 bit images and process them accord-
ingly.

 

Highlight/Shadow Points

Many digital images have a flat appearance due to a 
compressed dynamic range. This happens when pixel 
values don’t extend to the maximum range from 0-255. 
Highlight/Shadow Point converts the lightest pixel to 
white, the darkest pixels to black, and remaps all the 
pixels in between. A percentage of pixels on each end 
of the spectrum are clipped to insure a proper result. 
Clipped pixels are converted to black or white. The clip-

ping amount is adjustable by selecting one of the five preset clipping amounts in the Highlight 
Clip and Shadow Clip pop-up menus. You should use the smallest amount possible to avoid 
excessive data loss, and an overly contrasty appearance. 

Note: Highlights on a face can become burned-out quickly, so use judicially. 

Contrast
The contrast slider uses a custom S-curve that increases highlights, while decreasing shadows. 
An S-curve is the preferred method of professionals. The available range is -50% to +50%, in 
1% increments.

Color and brightness adjustments use an exclusive curve adjustment, as 
shown here. This method is designed to prevent data loss. The largest 
change occurs in midtone and shadow areas that contain the highest 
levels of saturation, with a less pronounced effect in the highlight areas.

SkinTune’s Contrast uses a custom S-curve adjustment, with high-
lights moving in the opposite direction of shadows. This method is 
designed to prevent data loss. On most images, you’ll find that a 
1-5% increase will provide the necessary “snap” to improve contrast.

Equalize Color

These sliders are used to fine-tune the color 
obtained from the Hue Swatches. Use these 
controls for fine adjustments. 

Reset Button
When you click on the Reset button, SkinTune reverts to the original set-
tings that were applied when you last clicked on the original image with 
the eye dropper tool.

All the adjustments you have made will be lost, unless you make a Snap-
shot or Save History before clicking reset.

Sound Effect

When you make a Snapshot, a camera shutter release sound is played.

If you want, you can turn the sound effect off:

1. Start SkinTune.

2. Click the “i”button at the top right corner of the window. 

3. From the pop-up menu select “Turn off Sound.” 

This will change the default, so the sound effect will remain off unless you turn it back on.

Window Resizing

To resize the SkinTune window just click and drag the bottom right hand corner of the window 
with your mouse to resize the window. The standard close, maximize, and minimize buttons have 
also been added to the top of the window.
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Click-Points

Your flesh tone selection is an important first step in achieving good results. Here are some things 
to consider:

1. Select a mid-tone color. Choose an area that is a good representation of the average color, 
brightness, and saturation of the image.

2. If the overall skin color in your image is too red, as an example, click on an area that contains 
this color cast so SkinTune can try to fix it.

3. Avoid shadows and highlights.

4. Avoid facial hair and make-up.

5. The program takes a 7x7 pixel average based on your click point, so choose a smooth, uni-
form area.

6. At any time, you may select a new click-point, which will reset the results.

Checking Your Selection
After you make a selection, check to make sure you are within range.

Based on your click-point selection, SkinTune finds the nearest acceptable skin color from the 
library. If the Current image comes up looking bad, it is an indication that your click-point fell out-
side the boundaries of the library. The solution is to click on a different area of the face until a more 
desirable Current image appears. See the section above regarding click-points. 

Be sure to click an area that puts the saturation and brightness sliders towards the middle of the 
slider instead of the ends. On an overall light image choose a darker area, and on a dark image 
choose a lighter area. That way you will avoid the boundaries of the library and make the correc-
tion a midtone adjustment. Whenever you are near the minimum or maximum values, whether 
in Photoshop features or with SkinTune, the adjustment range will be restricted and provide less 
quality.

Next, understand that your click-point selection is just the beginning of the correction process. 
This first step is required, because SkinTune needs a target point from the library to set all the slid-
ers and parameters. The library data is used to control all the subsequent adjustments you make. 

Your click-point selection is used to set Hue, Brightness, Saturation, and Equalize. When you adjust 
any of these, SkinTune refers to the specific data regarding the nationality. Each library is compiled 
from thousands of skin tone samples. 

The hue range is displayed on the color swatches, with current target color highlighted. You can 
click to select a new target color. Again, stay away from the 4 or 5 color swatches located on the 
far right and left edges. These hues are only provide to give you a larger working range and they 
fall outside the actual skin color spectrum.

The available spectrum for skin is very, very, limited, so minor adjustments are usually all you need. 
SkinTune’s hue adjustment offers twice the precision of Photoshop.
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Using The Snapshot Function
The Snapshot button (camera) is located under the right-hand preview image. You can record up 
to four Snapshots of your work. After that, you will be prompted to replace a Snapshot whenever 
you make a new Snapshot.

 A Snapshot makes a temporary copy of any state of the image, and lets you work from that point 
forward. In this way, you can experiment, or compare different effects while retaining a copy of 
your previous edits.

For example, you can make changes and tweak colors, take a snapshot, and then display and 
compare different versions side-by-side. Then, take another Snapshot any time you have made an 
improvement, so you can recover your work easily. Just select a Snapshot from right-hand pop-up 
menu to recall the previous saved version. 

The “View” and “Edit” pop-up menus, located under the preview images, are used to control and 
manage the Snapshot functions. When a Snapshot is selected from the right-hand pop-up menu, 
the sliders are updated to reflect the adjustments saved with the Snapshot. Only the right-hand 
preview can be edited. Displaying a Snapshot in the left-hand preview is for display purposes only.  

The pop-up menus contain the following items:

Left Menu Right Menu

Original Current

Wizard Snapshot Wizard Snapshot

Snaphot 1-4 Snapshot 1-4

Save History...

Load History...

Managing Snapshots 
Every time you make a Snapshot, it is listed in both pop-up menus located under the preview 
images. You can use the pop-up menus to display any combination of Snapshots you’d like. Only 
the preview image on the right can be edited and altered with the sliders. Whenever a Snapshot is 
displayed on the right, the sliders are updated to show the recorded adjustments that were saved 
with the Snapshot. You could load Snapshots on both the left and right, so you can compare two 
images side-by-side while you make changes.

If you make changes to a Snapshot, and then switch to a different Snapshot, SkinTune will ask if 
you want to save the changes before you switch. 

If you want to make a new Snapshot, and you’ve used up your allotment of 4 Snapshots, SkinTune 
will ask you which of the current Snapshots you want to replace. 

Typical Workflow
Like everything in SkinTune, Snapshot is designed to speed up the correction process. Snapshot 
is a safety net that lets you continue experiment with different combinations without losing your 
previous edits. Take a Snapshot whenever you want to preserve a set of correction parameters so 
you can continue experimenting with impunity. Here’s a typical workflow using Snapshot:

1.Make your normal adjustments.

2.Take a Snapshot to record your adjustments.

3.Then experiment with other edits, and make another Snapshot.

4.Use the pop-up menus to compare different Snapshots.

5.Save History if you want to reuse your changes on a future image, or click OK to process the 
changes shown in the right-hand preview.

Save History and Load History 
Snapshots are a temporary record of your image adjustments. But, you can permanently save an 
unlimited number of Snapshots to disk. To save on your hard disk, choose the Save History option 
in the Current pop-up menu, and specify a name and location for the file. Use the Load History 
option to open a previously saved setting. Load History will overwrite and become the Current 
preview. Then, you can edit the Current image using all of the tools in SkinTune.
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Last Filter

SkinTune supports Photoshop’s Last Filter command located at the top of the Filter menu. This lets 
you replay SkinTune’s last correction on other images. The menu item is available until you use a 
different filter.

Fade

SkinTune supports Photoshop’s Fade command, which is located in the Edit menu. This allows you 
to reduce the effect of SkinTune’s last adjustment from 0-100%. The Fade command is similar to 
changing the layer opacity in Photoshop’s Layer Palette.

Photoshop CS3 Smart Filters 

Smart Filters is a great new Photoshop CS3 feature that essentially let plug-ins work like Adjust-
ment Layers. SkinTune is compatible with CS3 Smart 
Filters, so adjustments can be recorded as a separate 
layer, and you can double-click the layer to edit Skin-
Tune’s alterations. This means you can use SkinTune 
to perform nondestructively editing when used on a 
Smart Object. 

Smart Filters are stored as layer effects in the Layers 
palette and can be readjusted at any time, working 
from the original image data contained in the Smart 
Object. Add,  
adjust, and remove filters from an image without hav-
ing to resave the image or start over to preserve qual-
ity. Nondestructive Smart Filters allow you to visualize 
changes without altering original pixel data.

To use Smart Filters:

1. First change the image layer to a Smart Object. In the Layer menu or Layer Palette options, 
choose Smart Object > Convert to Smart Object. 

2. Then use SkinTune to color correct the image.

3. To edit the SkinTune Smart Filter, double-click the layer.

4. When SkinTune opens, select Last Filter from the Edit pop-up menu under the right-hand pre-
view image. 

If you are not using the Smart Filter feature, Last Filter will apply the same change that was made 
during the previous SkinTune session.

To use SkinTune on selected areas
1. Choose any of Photoshop’s selection tools and select a portion of the 
image. Often using a color range selection is useful for color correcting 

only the skin in SkinTune.

2. Open SkinTune, and make changes as you normally would. The corrections will only be applied 
to the selected areas.

Using SkinTune With Photoshop

Photoshop Layers

Photoshop lets you place artwork on separate layers to make 
the construction of composite images easy. SkinTune is de-
signed to work with Photoshop layers, so you can color correct 
individual elements separately.

To use SkinTune with layers
1. Display the Layers palette (choose Window>Layers).

2. To activate a layer and work on its contents, click on the 
appropriate layer name listed in the Layers palette. The layer 
is highlighted to show that it has been selected. Then, open 
SkinTune.

3. To work on a portion of one layer, select the layer as de-
scribed above and use a selection tool to select a portion of 
that layer. Next, open  

SkinTune. The adjustments will be applied to the selected area.

Batch Processing

SkinTune supports Photoshop’s Action Palette, so multiple images can be processed automatically, 
with SkinTune’s functions.

Using Photoshop’s Actions 

1. From within Photoshop’s Action Palette, start a new Action. 

2. Photoshop will record every step, including SkinTune functions, so they can be replayed on an 
image or a batch of images automatically. 

3. To replay the action on a single image, select the action in the action palette, and select “play.”

To replay the action on multiple images, choose Automate>Batch from Photoshop’s File menu. A 
dialog lets you select an action, choose a folder of images to process, and set other parameters for 
opening, closing, and saving files.


